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Uktady wspotrzednych w systemie robota

Word Base Tool User Object
Wersja 01/2018

W systemie robota wystepuje kilka / kilkanascie uktadéw wspo6trzednych, ktére
utatwiajg uzytkownikowi programowanie. Podstawowe uktady wspotrzednych
World / Base Frame sg zdefiniowane w podstawie robota (w przypadku stacji z
jednym robotem) kolejny uktad, ktory jest dostarczony wraz z robotem to uktad
narzedzia tool0. Pierwszg czynnoscia, ktdra nalezy wykonac¢ jest utworzenie
narzedzia ze zdefiniowanym punktem TCP. Narzedzie to bedzie niezbedne do
zdefiniowania uktadu Base Frame osi zewnetrznych (jesli wystepuja w systemie),
a nastepnie zdefiniowania uktadu wspoétrzednych uzytkownika User Frame badz
uktadu Object Frame.
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— Manual Guard Stop
=V PL-L-PCOCTKIS Stopped (Speed 100%)

£ Jogging - Tool

Current selection: tooll

Select an item from the list.
Tool Name / [ Modute
tool0 RAPID/T_ROB1/BASE Global

Change Value...

Change Dedaration...
Copy
Delete
Define...
New... Edit 'f’ oK Cancel
PROCEDURA DEFINIOWANIA TCP NARZEDZIA
Definiowanie TCP
Centralny punkt narzedzia (Tool Centre Point)
A DRI
MmppD

Przed czynnosciami opisanymi w tej czesci nalezy zdefiniowa¢ TCP narzedzia, ktoérym
bedziemy definiowad uktad wspotrzednych uzytkownika. Szczegoty w Temat nr 3.
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ZASTOSOWANIE STOZKOW DO DEFINIOWANIA UKLADOW WSPOLRZEDNYCH

Uktady wspétrzednych Work Object ,,Wobj”

Materiaty dodatkowe: Instrukcja obstugiIRC5 z Flexpendant

Podstawowy uktad wspétrzednych uzytkownika—User Frame A RD
MRpp

Rysunek przedstawia model 3D przyrzadu na stanowisku zrobotyzowanym z
widocznymi stozkami stuzacych do definiowania dwoéch uktadow wspotrzednych.
Zamiast stozkdw mozna réwniez nabi¢ punkty na ramie przyrzadu lub wygrawerowac
znaki np.,,.+” z oznaczeniem X1, X2 Y.
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Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 z Flexpendant
Podstawowy uktad wspdtrzednych uzytkownika - User Frame

Uktad wspotrzednych Work Object ma dwie sktadowe. Pierwszg z nich jest User
Frame (uktad uzytkownika) drugg Object Frame (uktad obiektu). Zazwyczaj
wystarczy stosowanie uktadu User Frame.

Definiowanie uktadu wspotrzednych uzytkownika polega na wskazaniu
zdefiniowanym TCP narzedzia uzytkownika punktow charakterystycznych X1 X2
Y1 na podstawie tych trzech punktéw system wygeneruje uktad wspotrzednych
uzytkownika zapisany w danej typu wobjdata. Kierunek osi Z wyznaczony jest
wedtug reguty prawej reki, to znaczy jesli wewnetrzna czes¢ palcdw prawej dioni
bedzie kierowac sie od osi X w strone osi Y do kciuk wyznaczy kierunek osi z.
Zasada tworzenia uktadu: Zdefiniowanym punktem TCP narzedzia zblizamy sie
jak najdoktadniej do punktu charakterystycznego, ktory bedzie punktem X1 i
zapisujemy potozenie tego punktu w przestrzeni. Tworzymy p. X2. Przez punkt X1
do X2 biegnie 0$ X. Po zdefiniowaniu punktu Y system wyznacza prosta
prostopadtg do osi X, przechodzaca przez punkt Y. Miejsce przeciecia osi Y i X
jest poczatkiem uktadu wspotrzednych.
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WYZNACZANIE UKtADU WSPOLRZEDNYCH OBIEKTU

Uktady wspétrzednych Work Object ,,Wobj”
Instrukcja obstugi IRC5 with Flexpendant
Dodatkowy uktad wspétrzednych uzytkownika - Object Frame

AL b HD
nRppp

Podobnie wyznacza sie uktad Object Frame (uktad wspo6trzednych obiektu)
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— Manual Guard Stop
=V Q& PL-L-PCOCTKIS Stopped (Speed 100%)
£ Jogging
r— Tap a property to change it Position
Mechanical unit: ROB_1... 1: 19.84 ©
Absolute accuracy:  Off 2 56.49 ©
3: -38.20 °©
Motion mode: Axis 1 - 3... 4: 0.00 °
. o
Coordinate system: World... 2 I;;: ¢
Tool: tooll... ]
Work object: wobjo0... Position Format...
Payload: loado... Soystick directions
Joystick lock: None... e
Increment: None... 2 1 3
Align... Go To... Activate...

KJwRIZ;NlIEa;S;F;M;vspéirzqdnych Work Object ,,Wobj”

Instrukcja obstugi IRC5 with Flexpendant

ABB Menu > Jogging > Ustaw prawidtowe narzedzie, ktére bedzie wykorzystane przy definiowaniu Wobj

Naciénij,,Work object”

W celu zdefiniowania uktadu wspo6trzednych uzytkownika nalezy klikngé

U ABB Menu

U Menu Jogging

O Nacisna¢ linie Tool i wybra¢ narzedzie ktérego TCP bedzie wskazywac¢ punkty
X1,X2,Y1 uktadu wspo6trzednych. W tym przyktadzie bedzie to tooll

O Nacisnij i przytrzymaj przycisk Enable (Dead man switch) aby uruchomié¢ silniki
robota

U Ustaw narzedzie w orientacji zblizonej do pionowej stosujac reorientacje

O Nacisna¢ przycisk Align... (Wyréwnaj) funkcja ta stuzy do ustawienia uktadu
wspotrzednych aktywnego narzedzia (tooll) rownolegle do najblizszych osi uktadu
np. World (lub Base Frame) >
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p— Manual Guard Stop
=V Q& PL-L-PCOC7KI8 Stopped (Speed 100%)

£ Jogging - Align

Current tool: tooll

1. Select coordinate system to align the currently selected tool to:
Coord: [ |w°r|d

2. Press the enabling device then tap and hold ‘Start Align’.

[ Start Align

3. When ready tap 'Close'.

TWORZENIE USER FRAME

Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 with Flexpendant

ABB Menu > Jogging > Align... A RD
MRPpD

O Nacisnij przycisk Align... (Wyroéwnaj) funkcja ta stuzy do ustawienia uktadu
wspotrzednych aktywnego narzedzia (tooll) rownolegle do najblizszych osi uktadu
np. World (lub Base Frame)

O Nacisnij i przytrzymaj przycisk Enable (Dead man switch) aby uruchomié¢ silniki
robota

QO Nacisnij i przytrzymaj przycisk Start Align do momentu az robot zakonczy ustawienie
narzedzia w pozycji pionowej

QO Nacisnij Close (Zamknij)
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— Manual Guard Stop
=V % PL-L-PCOCTKIS Stopped (Speed 100%)
£ Jogging
r— Tap a property to change it Position
Mechanical unit: ROB_1... 1: 19.84 ©
Absolute accuracy: Off 2 56.49 ©
3: -38.20 °©
Motion mode: Axis 1 - 4: 0.00 °
Coordinate system: World... g I;g z
Tool: tooll...
Work object: wobj0... ] Position Format...
Payload: loado... T Soystick direct
Joystick lock: None...
Increment: None... 2 1 3
Align... Go To... Activate...
|7 D)

TWORZENIE USER FRAME

-]

Hold To'Run

Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 with Flexpendant

ABB Menu > Jogging > ,Work object”

AL b HD
nRppp

Nacisng¢ linie Work object pojawi sie lista work object’6w dostepnych w systemie



DYDAKTYKA ABB

— Manual Guard Stop EX
=V % PL-L-PCOCTKIS Stopped (Speed 100%)
r==————=——"|£3 New Data Declaration
@é Data type: wobjdata Current Task: T_ROB1
£ Jogging - Work .
| Name: [ IWOb}'l'
Current select Scope: ITask
Select an item fro Storage type: IPersistent
Work Object Nam Task: IT_ROBl
obBETemp
Module: B
obBEZero [ | mService
obHCBETemp Routine: I <None>
obHomeJoint Dimension: | <None> ﬂ ‘
wobj0
_ [Inlﬁal Value OK
Production
[Cnew ] 55
Prod ROB_1
Vindow Y
—_—

DEKLARACIA

Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 z Flexpendant

Nacisnij,New...” > Wpisz nazwe nowego Wobji pozostate dane > Naciénij ,Initial Value” AR

a1 ]

O Nacisna¢ New... (Nowy) wpisac jego nazwe naciskajac przycisk [...],

O Wybra¢ nazwe modutu, w ktérym by¢ zapisana definicja uktadu (wobjdata), jesli nie
zostat wczesniej utworzony modut uzy¢ modutu user

O Nacisnac Initial Value zaznaczy¢ opcje ufprog TRUE nacisngé¢ OK

10
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— Manual Guard Stop X
=V @% PL-L-PCOCTKIB Stopped (Speed 100%)
25 Edit

Name: wobj1

Tap a field to edit the value.

Name [ Value I Data Type 1to 6 of 24

wobj1 :- [FALSE, TRUE,"",[[0,0,0... wobjdata

robhold := FALSE bool

ufprog := TRUE bool

ufmec := string

uframe: [[0,0,0],[1,0,0,0]] pose

trans: [0,0,0] pos gv

0K Cancel
ROB_1
B ) 1% ®
—

UFPROG - USER FRAME PROGRAMOWALNY

Uktady wspétrzednych Work Object ,,Wobj”
Instrukcja obstugi IRC5 z Flexpendant

W przypadku gdy uktad uzytkownika nie bedzie zwigzany z osig ruchomg manipulatora zaznacz ,ufprog := TRUE” > OK

AL b HD
nRppp

Nacisng¢ Initial Value zaznaczy¢ opcje ufprog TRUE nacisna¢ OK > OK

11
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£ Jogging - Work Object

— Manual Guard Stop
=V PL-L-PCOC7KI8 Stopped (Speed 100%)

Current selection: wobj1

Select an item from the list.

Work Object Name ! Module

obBETemp RAPID/T_ROB1/#SYS
obBEZero
obHCBETemp

Change Value...
Change Declaration...
Copy

Delete

obHomeJoint

DEFINICIA

Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 z Flexpendant

Zaznaczyc¢utworzony wobjlinacisng¢ ,Edit” > ,Define...”

O Zaznaczy¢ nazwe utworzonego uktadu wspotrzednych tutaj wobjl
O Nacisnac przycisk Edit (Edytuj) i Define... (Definiuj)

AL b HD
nRppp

12



pr— Manual Guard Stop
— % PL-L-PCOCTKIS Stopped (Speed 100%) x

2 Program Data -> wobjdata -> Define

Work Object Frame Definition
Work object: wobj1 Active tool: tooll

Select a method for each frame, modify the positions and tap OK.

User method |3 points w| Object method [No Change W

Point Status 1to3of 3}

User Point X 2
User Point Y 1

Pndtlons‘ Modify 0K Cancel
ROB_1_ |
B B
POMOC

Uktady wspétrzednych Work Object ,,Wobj”

File > Help > IRC5 with Flexpendant

Zachowujackolejnos$c przesun robota nad wyznaczone punkty i zmodyfikuj ,,User Point X1, X2, Y1” naciskajac przycisk AR
»Modify Position” > OK mPpPp

O W zaktadce User method wybrac (3 points) (3 punkty)

Q Zaznaczyc linie User Point X1

O Nacisna¢ i przytrzymacé przycisk Enable (Dead man switch) i przesunaé ruchem
liniowym narzedzie nad stozek (lub punkt), ktory bedzie pierwszym punktem
definiujacym uktadu (X1). Ustawi¢ TCP narzedzia jak najblizej konca stozka bez
spowodowania kolizji,

O Nacisnac na panelu Flexpendant przycisk Modify position (Modyfikuj pozycje).

O Wykona¢ analogicznie te czynnosci dla punktu X2 i Y1

O Nacisng¢ OK
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— @ Manual Guard Stop BX
— V [aa) PL-L-PCOC7KI8 Stopped (Speed 100%) x
£ Edit

Name: wobj1

Tap a field to edit the value.

Name [ value | pata Type
wobj1 : [FALSE,FALSE,"",[[0,0,0... wobjdata

Aktywuj
jednostke

robhold := FALSE bool STN1/STN2
ufmec := = string —
uframe: [[0,0,0],[1,0,0,0]] pose
trans: [0,0,0] pos
TRUE FALSE Refresh OK
b )
Window
—_— I

POMOC

Uktady wspétrzednych Work Object ,,Wobj”

File > Help > IRC5 with Flexpendant

W przypadku gdy uktad uzytkownika bedzie zwigzany z osig ruchoma manipulatora zaznacz ,ufprog := FALSE” > nacisnij AR
ufmec:=,” Il d

W przypadku, gdy uktad wspoétrzednych uzytkownika musi by¢ ,,przymocowany” do osi
zewnetrznej robota, np. osi manipulatora i obracac sie wraz z nig, definiowanie uktadu
ma nieco inny przebieg.

O Nalezy nada¢ nazwe ukfadu i ustali¢ w ktorym module powinien by¢ zapisany. Po
nacisnieciu przycisku Initial value (Wartosci poczatkowe) nalezy:

O Zaznaczy¢ ufprog FALSE (User frame nie bedzie programowalny inaczej zdefiniowany
przez uzytkownika, gdyz system automatycznie zdefiniuje go w uktadzie Base Frame
osi manipulatora)

Q Zaznaczy¢ ufmec

14
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~~~~~ Guard Stop. 3 K= Manual Guard stop. % [[G7] = Shianl Cakiinig X
=v| Qv s (X] MR it B[ Ev| R [ ey X
wobj1.ufmec wobj1Lufmec £ Program Data -> wobjdata -> Define
‘ . Work Object Movable Frame Definition
Work object: wobj1 Active tool: tWeldgun
vif2f|3ja)fsyefz|fef |- (€ Select a method for object frame, modify the positions and tap OK.
allwllellrllellyllulloellollellc]i User frame from: STN1 Object method [ points 4
Point Status E f
o |lalls|dfff]lag]lnf]s(«]|?
Object Point X 1
st [z || x| c| v|bfnf|m]|. /|| Home Object Point X 2
Object Point ¥ 1
Intl \ Tt 1= = End
oK Cancel A Modify
oK Cancel Positions g oK Cancel
RoD_1 [ — RoB_1
1 v @ | Sl ¥ @

USER FRAME ZDEFINIOWANY W UKLADZIE BASE FRAME OSI ZEWNETRZNEJ]

Uktady wspétrzednych Work Object ,,Wobj”

Instrukcja obstugi IRC5 z Flexpendant
Nacisnij ,Mechanical Units” i wybierz nazwe jednostki do ktérej zostanie , przymocowany” Wobj > OK > OK > OK > OK
Zaznacz utworzony Wobj > Edit > Define...> postepuj analogicznie do tworzenia User Frame utwérz Object Frame

AL b HD
AN MDD

W oknie, ktére zostanie wyswietlone nalezy:

O Nacisnac przycisk Mechanical Units (Jednostki mechaniczne)

Q Z listy, ktora zostanie wyswietlona nalezy wybraé¢ naped do ktérego przymocowany
zostanie uktad User frame tutaj STN1

Q Zatwierdzi¢ OK > OK > OK > OK

O Na ramie przyrzadu przymocowanego do osi zewnetrznej (STN1) zaznaczy¢ punkty
X1, X2,Y1

O Aktywowac os zewnetrzng (ActUnit)

QO Zaznaczyc¢ z listy wokobject’éw ten utworzony przez uzytkownika,

O Nacisnac Edit > Define...

O W oknie Object method wybrac¢ metode 3 punktowa

QO Zdefiniowad punkty X1, X2, Y1 tak jak w poprzednim przyktadzie.
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